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WHAT IS NUMBERS? 

Numbers is Apple’s version of  Excel, which is a spreadsheet program. These apps make it 
possible to manipulate and analyze data. You can use it for accounting purposes or as a way to 
create lists of  various components and be able to sort them as you wish. It is free to use, whereas 
Microsoft’s Excel is not. You can easily open an Excel document and save your Numbers 
document as an Excel document so that it is quite useable and in many ways simpler than Excel 
to use. Excel is packed with more features than most of  us will ever use, while Numbers takes a 
more basic approach. Notes also that Numbers is also free on your iOS device as well as your 
Mac. 

Similar to Pages, you first start with a Template, either one that is already pre-designed or one 
of  your own creation. You can save templates if  you plan on using a similar format in the future. 

I highly recommend watching David Cox’s TechTalk American YouTube video on this and also 
select the CC for closed captioning so that you get the transcription as you watch. He does a 
great job in 12 minutes of  showing us how to use Numbers. The link for this video is:  https://
www.youtube.com/watch?v=-XCkLnIPaL4  

HOW TO USE NUMBERS: 

Apple has lots of  info for your use on Numbers. Here are some links for you to take a peek at: 
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Their Users Guide:  https://support.apple.com/guide/numbers/welcome/mac and here are 
the categories covered:  
Here is their site introducing Numbers where they start with opening a template and then how 
to add your own data:  https://support.apple.com/guide/numbers/intro-to-numbers-
tan0eca1a9ab/mac. And more info on creating a spreadsheet:  https://support.apple.com/
guide/numbers/create-a-spreadsheet-tanc33201f3f/6.2/mac/1.0 

Here is their site on how to create and use templates:  https://support.apple.com/en-us/
HT209567. You can also download a ton of  free templates at this website:  
iworkcommunity.com. They have templates for all of  the Apple suite = Pages, Numbers and 
Keynote. The one for Numbers is:  https://iworkcommunity.com/numbers/ 

ROWS & COLUMNS: 

You all know that a row goes across a page and a column goes down a page. Here is what you 
need to know to work with them: http://numbers.skydocu.com/en/add-and-edit-tables/
working-with-rows-and-columns/. You will need to know how to freeze header rows and 
columns so that your headers will appear on all pages as well as when you scroll the spreadsheet.  
More on how to freeze them here:  https://www.idownloadblog.com/2018/11/02/freeze-
columns-rows-in-numbers/ .  You will need to know how to add or delete a row or column or 
move a column or row to a different placement. 

To transpose a row or column, so that rows become columns and columns become rows, you 
need to select the table, -> Table -> Transpose rows and columns. It is a bit different on your 
iOS device, so here is all you need to know about transposing: https://
www.idownloadblog.com/2018/10/17/transpose-in-numbers-rows-and-columns/ 

Autofill is also available in Numbers, but it works a bit differently than in Excel. It lets you 
quickly fill other cells with data from adjacent ones. You can fill things like patterns, words, and 
numbers, up, down, left, or right. But when it comes to filling down and you have hundreds or 
thousands of  rows, it can get tricky. Here are the details on how to do this with columns and 
rows:  https://www.idownloadblog.com/2019/03/27/fill-down-numbers-autofill-mac/ 

MERGING CELLS: 

Sometimes you want to merge cells so that the information you have typed will cross over 
multiple columns. This is how you can use a title covering the entire width of  your spreadsheet. 
Here is how to do this, as it is not intuitive…:  1) Select the cells you want to merge. Remember, 
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the cells must be next to each other in a column or row. You can select them by clicking the first 
one and dragging through the rest. Or, by clicking the first cell, holding down the Shift key, and 
clicking the last cell. 
2) Click Table from your menu bar. 
3) Select Merge Cells. 

For more information on this, and to find out how to UNMERGE those cells, read this article:  
https://www.idownloadblog.com/2018/10/25/how-to-merge-cells-in-numbers-mac-ios/ 

FORMATTING:   

If  you want to punch up your file with a pop to the title or elsewhere in your spreadsheet, you 
can add a gradient color tot he text or use an image to fill the text, or use an outline in the text. 
Here is how to make these eye-popping texts:  https://support.apple.com/en-us/HT210063 

Do you want to add a shape to your document, perhaps text with a shape? Here is how:  
https://support.apple.com/en-us/HT207770 

PRINTING: 

Printing in Numbers is goofy. This is the one part of  the app that I do not like. I like to have a 
page layout view as I am editing and Numbers does not allow for this. You have to go to the 
Print function to see where the pages will break and then back to the spreadsheet to amend the 
width of  the columns or rows. If  you spreadsheet is not too large, you can force it to print as a 
single page by either going to Print and select sale to fit on 1 page OR, you can select the area 
you want printed, copy it and then open Preview and open a new document “from clipboard”. 
Here is more on that:  https://www.cultofmac.com/219157/get-numbers-spreadsheets-printed-
on-one-page-os-x-tips/. To get more information on printing, read this:  http://
numbers.skydocu.com/en/share-and-print/print-a-spreadsheet/ 

If  you want gridlines to appear on your printed document as they appear in the app, go to the 
Format menu and select Cell in upper right of  window. Down below that right side you will find 
all of  your various border options, as well as various fill options for the cells selected. 

HINTS & TIPS: 
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You will need to master the basics of  the app and here are some that you should know: 

• Add Rows and Columns: Add a row within Numbers by right-clicking a cell within a 
corresponding row and selecting Add Row Above or Add Row Beneath. Add a column 
within Numbers by right-clicking a cell within a corresponding column and selecting Add 
Column Before or Add Column After. 

• Add a Worksheet: Click the + icon that appears toward the top left of  the currently displayed 
worksheet 

• Configure Data Formats: With the corresponding cell(s) highlighted, display the Inspector 
pane, which appears on the application's right, confirm the Format icon is selected and use 
the drop-down menu within the Cell tab to set a cell's data format. Display the Inspector 
pane by clicking within a cell or clicking View from the Numbers menu bar and selecting 
Inspector and then Show Inspector, if  the Inspector view was previously hidden. 

• Configure Cells: Highlight the corresponding cell(s), display the Inspector pane, confirm the 
Format icon is selected, and click the Cell tab to configure cell fill and borders, as well as 
conditional highlighting settings. 

• Configure Cell Text: Highlight the corresponding cell(s), display the Inspector pane, ensure 
the Format icon is selected, and click the Text tab to configure font, alignment, text wrapping, 
and spacing. 

• Freeze/Unfreeze Header Row: Freeze and unfreeze header rows by highlighting the row 
number that appears on the left of  the Numbers application, clicking the down arrow that 
appears and selecting Freeze Headers Rows to check or uncheck the selection as you desire. 

• Insert Sums, Averages, and Other Values: Highlight the cell where the value should be 
entered, and then click Insert from the Numbers menu bar, click Formula, and select the 
corresponding operation. Alternatively, you can highlight the cell where the total should be 
placed and click the Insert icon that appears within the Numbers toolbar and then select the 
corresponding operation--be sure to double-check and confirm Numbers calculates the 
correct cells (which the application highlights by default). Note: You can adjust the chosen 
cells by double-clicking the cell in which the operation appears, manually adjusting the 
described cells, and clicking the Green checkmark to save the change. 

• Insert Chart: Highlight the corresponding cells and click the Chart icon within the Numbers 
toolbar, and then select the type of  chart you wish to create. Numbers will place the chart 
within the sheet. 



• Insert Table: Display the Inspector pane, ensure the Format icon is selected, click the Table 
tab, and then use the provided header and footer, table outline, and row and column size 
settings to configure the table 

• You should know how to save a Numbers as an Excel doc if  you are collaborating with others 
who only have/use Excel. Once you have your Numbers document done, simply go to File -> 
Export -> Excel (for more information on how to do this with both a Mac and an iOS device, 
read this article:  https://www.igeeksblog.com/how-to-convert-numbers-file-to-excel-on-mac-
iphone-ipad/ 

• You should use the templates already prepared in Numbers to save time and perhaps 
aggravation… 

• If  your information is confidential, you can set a password for that document by simply 
selecting the File Menu and selecting Set Password. 

ADDITIONAL NOTES TAKEN AT MEETING: 

There were some additional questions and comments that came up during the meeting as 
follows: 

1.).  Doug reminded us that we can get a 50% off  the subscription to TheMacU website chock 
full of  useful tutorials. I believe the cost is around $25/year, so half  would be $12.50, or you can 
go with the lifetime subscription which is normally $125 or $62.50 after the discount. To get this 
discount, you need to enter the following code “ RMUG “. Thanks Doug! Here is the link to 
their webpage:  https://themacu.com/  

2.).  Pages and Numbers has a wonderful feature of  saving all your work as you make your 
changes. But, what if  you wanted to go back to a previous version? Simple! Go to the File menu 
then Revert To and then Browse all Versions. It will take you to a Time Machine type “file” and 
you can now browse thru all the versions saved and select the one you wanted. Super simple and 
very useful… 

3.).  Did you know that using the Option Key while clicking on the various menu bar items 
brings you some new options to those menu items? For instance, while in Finder, if  you click on 
the Go menu and while there, click the Option key, you will see some new items, one of  which is 
your User Library. That is a great shortcut to this folder… But, this does not stop there. The 
same kind of  thing works in all of  the apps. Just select the File menu in Pages, for example, and 
you will see that when you click on the Option key, you will now see the Save As instead of  
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Duplicate and Close All instead of  simply Close. I recommend you try this in many of  your 
apps and you will find some useful shortcuts! 

4.).  I find the Sidebar in a Finder window to be very useful as a shortcut to many other folders I 
frequent often. One of  these is my User Folder. You can add any folder you want to the Sidebar 
by simply clicking and dragging its icon to the Sidebar.  

5.).  Lastly, in order to find your phone’s last location (you may have lost your phone and it is 
now out of  juice…), you need to enable that in your iPhone’s Settings. Go to your Apple ID, the 
top item in Settings, and go down to Find My. Once there, make sure that Find my Phone is on 
and click on it to get more settings.One of  the items you need to turn on is “Send Last 
Location.” Once you do this, you will be able to find where your iPhone was last on and 
hopefully be able to actually find the phone. This is very handy when your phone is out of  
battery and the send a sound does not work because of  that…


